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Create a Journal or Batch 

Introduction 
 

Purpose 

Use this procedure to enter journals or batches in Oracle Financials. 
 

Trigger 

• You have journal entries that need to be entered online and posted to the Oracle General Ledger. 
 

Access General Ledger through the Oracle Gateway 

1. To access the General Ledger go to https://huit.harvard.edu/finance under Oracle Financial Gateway click 
on the link for Oracle System Applications, Personal Homepage. 

2. Log in through Harvard Key.  The Oracle Applications Home Page will open. 

3. From the Home Page, select your General Ledger Responsibility (HRVD^GL …), then Journals, Enter. 

 

If you receive a dialog box with one of the following messages: 

• Do you want to run this application? Click the Run button. 
• “The application's digital signature cannot be verified.  Do you want to run the 

application?”  Click the Run button.  Note that you may see this message twice. 
• “Your Java version is out of date.” Click the “Later” button, unless directed by Oracle EBS 

FINDINI Release Notes to update.   
 

Helpful Hints 

All journal entries in a batch must share the same accounting period. 

  

https://huit.harvard.edu/finance
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Find Journals 
Selecting Journals, Enter brings up the Find Journals screen. 

 

 
 
1. Perform one of the following: 

 

If you need to Then Go To 

Create a journal batch Click   
Step 2 

Create a journal entry Click    Step 4 

 
Oracle will create a batch for you if you create a journal without explicitly creating a batch.  
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Batch 
 

 

2.  As required, complete the following fields to enter batch information.   
Note that all required fields appear in yellow on the screen. 

Field Required/Optional/Conditional Description 

Batch Required Use Naming convention for batch name 
 

• PREPARER’S TUB INITIALS (UPPERCASE) 
• PREPARER’S INITIALS (UPPERCASE) 
• Purpose of the journal (Title Case) 

 
Example: HBS SDO Funding Transfers 
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Field Required/Optional/Conditional Description 

   Period Required Accounting period of the batch 
 
This field defaults to the most recent open 
accounting period. 
During the month-end, quarterly-end and year-
end closes, you may need to change the period 
to the appropriate month. 

Description Optional Purpose of the journal batch. 
  
For internal billings, the description should 
include the contact’s last name, first name and 
contact information such as telephone number. 

Example: Reclassification of computer supplies–  
Harvard, Jessica 508-555-1234 

(Batch) 
Control 
Total 

Optional Amount against which total debits / credits for the batch 
will be compared.  If used, all the debits / credits in the 
Batch must agree to the control total.  

 
 

3.  Click  to go to the Journals form.  
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Journals 

  

4.  As required, complete or review the following fields to enter the journal header information: 

Field Required/Optional/Conditional Description 

Journal Required Use Naming convention for batch name 
 

• PREPARER’S TUB INITIALS (UPPERCASE) 
• PREPARER’S INITIALS (UPPERCASE) 
• Purpose of the journal (Title Case) 

 
Example: HBS SDO Funding Transfers 
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Field Required/Optional/Conditional Description 

   Period Required Accounting period of the batch 
This field defaults to the most recent open 
accounting period. 
   
During the month-end, quarterly-end and year-
end closes, you may need to change the period to 
the appropriate month. 

Category Required Appropriate journal category 

The list of values can be selected by clicking .  
See the Appendix at the end of this document for 
a description of the most commonly used journal 
categories. 

 
 

Description Optional Purpose of the journal. 
  
For internal billings, the description should 
include the contact’s last name, first name and 
contact information such as telephone number. 
 

Example: Reclassification of computer supplies–  
Harvard, Jessica 508-555-1234 

(Journal) 
Control 
Total 

Optional Amount against which total debits / credits for the batch 
will be compared.  If used, all the debits / credits in the 
Batch must agree to the control total. 

 

5. Complete the following field for the journal line entry: 
 

Field Required/Optional/Conditional Description 

Line Required Number of the line 
 
Example: 10 
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Field Required/Optional/Conditional Description 

   
After the first line number is entered, Oracle will 
automatically number the lines that follow.  
If started with 10, the next line will be 20. 
An advantage of starting with line number 10 is that 
additional lines can be added in between at a later 
time if desired, line 12, line 15, etc.  

 

 

6. Perform one of the following: 
 

If Then Go To 

You are unsure of the 33-digit code Click    to prompt the 
HRVD Accounting Flexfield window. 

Step 7 

You know the 33-digit code Type in the Account , use a period as 
the  delimiter between values   

Step 9 

 
7. Complete the following fields to enter the Account value: 

Field Required/Optional/Conditional Description 

Tub Required 3-digit code for Tub. 

   Org Required 5-digit code for the Organization. 

Object Required 4-digit code for the Object Code. 
 Fund Required 6-digit describing the source of the money. 

Activity Required 6-digit code describing for what the money is being used. 

SubActivity Required 4-digit code for the discrete task within an activity. 

Root Required 5-digit code for the faculty or building related to the 
transaction. 
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Accounting Flexfields 

 

To search for a segment value: 

1. Select the  to the right of the segment.  The segment screen will appear.  In this example, 
Object will be used. 
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2. The wildcard (%) already appears in the Find screen.  Type the in all or part of the segment 

number or the description and click .  A list of values will appear.   

3. Highlight the appropriate value and click . 

 

8. When you have completed searching for and/or typing in your account values, click  to 
close the HRVD Accounting Flexfield window and return to the Journals window. 
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Journals 

 

   A description of the account displays in the Acct Desc field on the Journal form. 

 

9. Complete the following fields to enter the journal entry line information: 

Field Required/Optional/Conditional Description 

Debit 
or 
Credit 

Required Amount Debited or Credited 

   Description Required 

Purpose of the journal line entry 
This field defaults in from the journal description 
above, if that is filled in, but can be modified. 
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Descriptive Flexfields 

The Oracle General Ledger contains fields that Harvard has customized to serve specific information 
needs related to journal entries. These additional fields are termed descriptive flexfields (DFFs).  
The journal line descriptive flexfields are located on the journal screen and are indicated by the 
small boxes to the right of the journal lines section. 

 
Harvard has many journal line descriptive flexfields (DFFs). Most of the descriptive flexfields are 
context sensitive. This means that the additional field may be available depending on the object 
code that is entered in the account coding for that journal line. When descriptive flexfield (DFF) 
information is required for a particular journal line, a new window displays on the screen with 
additional fields to be completed. 
 
The journal line descriptive flexfields are listed below:  
 

• Originating Journal Name 
• Originating Journal Date 
• Harvard ID  
• Employee  or Student Name  
• GSAS Dept Affiliation 
• Fringe By-Pass 
• Effective  Month 
• Period of Work Performed 

 
 

10. If desired or required, select or tab into the DFF field to enter the additional information. 
 

If you are making an adjustment to a … Go To 

previous journal entry Step 11 

journal and have entered an object code that journals Payroll Step 12 

to a stipend, student receivable, or student loan transaction journal Step 13 
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Journal Entry-Descriptive Flexfields 

 

11. These fields are available on every journal line regardless of the object code entered.  They are 
expected to be completed when an adjustment journal is created for a prior transaction. 
 

• Originating Journal Name -  
Enter the batch or journal name associated with the transaction that is being corrected. 

• Originating Journal Date -  
Enter the batch or journal date associated with the transaction that is being corrected. 
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Payroll Adjustment Journaling-Descriptive Flex Fields 

 
 
12. Payroll Adjustment Journaling is expected to be done in the GL-PCR Tool.   
If a user is told by central accounting to instead enter a manual journal, these fields are to be 
completed when a journal is created. If a payroll object code is used, Harvard ID and Employee 
Name fields are required; the system will not let the user continue with the journal until these fields 
are completed.  
 

• Originating Journal Name -  
Enter the batch or journal name associated with the transaction that is being corrected. 

• Originating Journal Date -  
Enter the batch or journal date associated with the transaction that is being corrected. 

• Harvard ID (Required) - The 8-digit Harvard ID number for the employee whose payroll 
transactions are being adjusted should be entered in this field. 

• Employee Name (Required) - The full name of the employee whose payroll transactions 
are being adjusted should be entered in this field. The format is Last Name First Name. 

 
See Appendix 2 at the end of this document for a complete listing of object codes and their DFF 
requirements. 
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The Description of the fields is as follows: 
 

Field Required/Optional/Conditional Description 

Harvard 
ID 

Required Required for all Payroll & college work study transactions; 
optional for other student loan and receivable transactions. 

         Must be 8 digits. 

Employee 
Name 

Required Required for all Payroll transactions; 
optional for other student loan and receivable transactions. 

Fringe 
Bypass? 

Conditional The Fringe By-Pass DFF is an indicator to the fringe benefit 
program to ignore the payroll lines on the journal when the 
fringe benefit allocation is run.  
If a payroll journal is created and the fringe benefits associated 
with the payroll lines will be manually adjusted, this field 
should be filled in with a “C”.  
Enter the letter "C" in the DFF for the Fringe program to By-
Pass calculating the fringe. 
If it is desired that the fringe benefit program calculate the 
fringe, this field should be left blank. 
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Stipend, Student Receivables, or Student Loan Adjustment Journaling-
Descriptive Flex Fields 

 
 
13.  These fields are to be completed when a journal is created to make an adjustment to a stipend, 
student receivable, or student loan transaction.  Appendix 2 at the end of this document indicates 
when these fields are required; if the field is required, the system will not let the user continue with 
the journal until these fields are completed. 
 

• Originating Journal Name -  
Enter the batch or journal name associated with the transaction that is being corrected. 

• Originating Journal Date -  
Enter the batch or journal date associated with the transaction that is being corrected. 

• Harvard ID - The 8-digit Harvard ID number for the student whose stipend, receivable, or 
loan transactions are being adjusted should display in this field. 

• Student Name - The full name of the student whose stipend, receivable, or loan 
transactions are being adjusted should display in this field. The format is Last Name First 
Name. 
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The Description of the fields is as follows: 
 

Field Required/Optional/Conditional Description 

Harvard 
ID 

Required The 8-digit Harvard ID number for the student whose stipend, 
receivable, or loan transactions are being adjusted should 
display in this field.. 

         Must be 8 digits. 

Student 
Name 

Required The full name of the student whose stipend, receivable, or loan 
transactions are being adjusted should display in this field.  

         The format is First Name Last Name 

Fringe 
Bypass? 

Conditional The Fringe By-Pass DFF is an indicator to the fringe benefit 
program to ignore the payroll lines on the journal when the 
fringe benefit allocation is run.  
If a payroll journal is created and the fringe benefits associated 
with the payroll lines will be manually adjusted, this field 
should be filled in with a “C”.  
Enter the letter "C" in the DFF for the Fringe program to By-
Pass calculating the fringe. 
If it is desired that the fringe benefit program calculate the 
fringe, this field should be left blank. 
 

Dept. Aff Conditional This field is to be completed for GSAS student receivables 
transactions to indicate the 2-digit GSAS department to which 
the student belongs. The window displays if objects 6410, 
6430, or 6440 are used.  It is an optional field.  
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14. Perform one of the following: 

If Then Go To 

You need to add additional lines Tab or arrow down to the next line Step 5 

You do not need to add additional 
lines 

You are required user to fill in Harvard ID and 
Employee Name and give the option to fill in 
the Fringe By-Pass Code. 

Step 16 

 

   If you need to delete a line, click on the line to highlight it (a highlighted line will turn 
yellow in color). Select the Edit menu, then Delete, (or, if using keyboard equivalents, Alt-E, 

then D), or click on the Delete icon: . 

15. Perform one of the following: 

If you need to Then Go To 

Create another journal entry in the 
batch 

Select the File menu, then Save and Proceed, , (or, 
if using keyboard equivalents, Alt-F, then V). 

Step 4 

Add additional journal line entries Tab to the next Line field. Step 5 

 

16. If you have finished your data entry, click the Save icon:   or select the File menu, then Save 
(or, if using keyboard equivalents, Alt-F, then S) to save the journal. 

Status and Closing the Form 
 
Note the message “Transaction Complete: XX records applied and saved,” on the bottom left of your 
screen in the status bar. 
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To close the form, select File, then Close Form (or, if using keyboard equivalents, Alt-F, then C), or select 

the Close Form icon:  . You will return to the Enter Journals window: 

 

To enter another Batch, select  .  To enter another journal, select 

 . 

To close the General Ledger application, choose File, then Exit Oracle Applications  
(or, if using keyboard equivalents, Alt-F, then X). 
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Appendix 1: Journal Categories 
Correctly completing the Category field on the Journal Entry form identifies the purpose of the journal.  

Category Description Local or Central Usage 

Accrual Month End Accrual Entry Local or Central Month-end and year-end journal 
entries.  Used to accurately 
record income and/or expense in 
the month or year in which the 
expense is incurred or income is 
earned.  The University primarily 
operates on a cash basis and the 
use of accruals is a local Tub 
Financial Office (TFO) decision. 

Adjustment Adjusting Journal Entry Local or Central Correction of charges incurred 
against inappropriate chart 
values.  For example, to move a 
transaction from an 
inappropriate fund to the correct 
fund. 

Allocation Allocation Local or Central Redistributing or assessing 
income or expenses across 
various chart values.  For 
example, charging building 
expenses across a number of 
roots or charging a fixed fee to a 
group of funds. 

Balance Forward Balance Forward Local or Central Used to record adjustments to 
Balance Forward entries created 
during the year-end balance 
forward process. 

Cap Asset Sale Capital Asset Sale Central Sales of land, buildings, or 
equipment. 
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Category Description Local or Central Usage 

Cap Equip Reclass Capital Equipment 
Reclassification 

Central Reclassification of capitalized 
equipment from expense objects 
to asset objects.  

Carry Forward Carry Forward Journal 
Entry 

Local or Central Entries to move year-end balance 
sheet balances from the old fiscal 
year to beginning balance sheet 
balances for the new fiscal year. 

Chargebacks Chargebacks Central Used by General Accounts 
Receivable when writing off 
receivables.  

Debt Issuance Debt Issuance - Internal, 
External, Debt, Bond 

Central Recording receipt of external 
loan proceeds or the issuance of 
internal loans from the Center to 
the tubs. 

Debt Service Debt Service - Internal, 
External, Debt, Bond 

Central Payment of interest and /or 
repayment of principle 
associated with debt financing. 

Depreciation Fixed Asset Depreciation Central Entries to reduce book value of 
assets over the assets' useful 
lives. 

Discounts Discounts Central Used by University Financial 
Services Accounts Payable. 

Endow 
Capitalizations 

Endowment 
Capitalizations 

Central Recording of non-gift additions to 
endowment principal balances. 

Endow 
Decapitalizations 

Endow Decapitalizations Central Reductions of endowment 
principal balances to support 
current operations or projects. 
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Category Description Local or Central Usage 

HMC Journals Harvard Management 
Company Journals 

Central Journal entries created by or for 
the Harvard Management. 
Company 

Internal Billings Internal University Billing 
Activity 

Local or Central Transactions that occur within or 
between tubs.  Examples include 
internal sales of goods or 
services, transfer of funds 
between units, support from 
University funds, or cost 
reallocations. This category is 
required for all internal billings, 
as well as anytime an intertub or 
intratub object code is used. 

MELO Activity Mortgage and Educational 
Loan Office Activity 

Central Journal entries created for the 
Mortgage and Educational Loan 
Office. 

Month End Entry Month End Entry Local or Central Journal entries created to record 
month-end reclassifications and 
adjustments. 

Other Other Miscellaneous 
Transactions 

Local or Central Entries that do not fall into any of 
the other journal categories. 

Payments Cash Disbursements Central Entries to identify cash 
disbursements from the 
University to external parties 
(includes payments to students 
and employees). 

Purchase Invoices Accounts Payable Invoices Central Entries to record all invoices 
(including credits) from payables. 

Pyrl Casual Casual Payroll Local or Central All casual payroll entries, 
including manual adjustments. 

Pyrl Faculty Faculty Payroll Local or Central All faculty payroll entries, 
including manual adjustments. 
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Category Description Local or Central Usage 

Pyrl Pension Pension Payroll Local or Central All pension payroll entries, 
including manual adjustments. 

Pyrl Semi Monthly Semi Monthly Payroll Local or Central All staff payroll entries, including 
manual adjustments. 

Pyrl Special Special Payroll Local or Central Any payroll transaction that does 
not fall into and of the other 
payroll categories, including 
manual adjustments. 

Pyrl TFellow Teaching Fellow Payroll Local or Central All teaching fellow payroll 
expense entries, including 
manual adjustments. 

Pyrl Weekly Weekly Payroll Local or Central All weekly payroll expense 
entries, including adjustments. 

Quick Checks Quick Checks Central Transactions requiring a check to 
be cut on-the-spot. 

Receipts Cash, Gifts, other Receipts Local or Central Any receipt of funds. 

Revenue Revenue Local or Central Transactions to record revenue.  

Standing Orders Standing Orders Central Entries to endowment and gift 
funds required by the donor or 
by University policy. 

Stu Loan Activity Student Loan Activity Local and Central All entries relating to student 
loans. 

Stu Rcvbl Activity Student Receivable 
Activity 

Local and Central All entries relating to student 
receivables. 

Year End Entry Year End Entry Local and Central Journal entries created to record 
year-end reclassifications and 
adjustments. 

 
 



 General Ledger 
 A-15 
 Create a Journal or Batch 

August, 2022  For Harvard Business Use Only  Page 23 
Create a Journal or Batch 

HARVARD 
UNIVERSITY 

Appendix 2: DFF Requirements 
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